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Notice Date: 2016-08-15
This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users.
Incidents marked with an asterisk (*) in the first column of the tables below are more significant.

Changes from v18.1.1 (Released 2016-02-26)
User Interface
Enhancements Implemented
*

Incident
88053

91021

Description
An enhancement has been implemented to indicate in the Bridge Splice Property form and the
associated context-sensitive Help that splices are currently limited to steel I-girder deck sections.
There is no change to behavior of the software.
An enhancement has been implemented to provide an option to toggle whether the Properties of
Object floating form is displayed when drawing. This option was previously available in the menu
interface under Options and is now available in the ribbon interface under File > Settings > Other
Settings.

Graphics
Enhancements Implemented
*
*

Incident
93999

Description
An enhancement has been implemented to allow displaying all loads, within a single load pattern,
on all object types, in a single display. The new option is available from the Home tab > Display >
More > Show Object Load Assignments > Load Pattern command.

Bridge Modeler
Enhancements Implemented
*

Incident
78065

80617

Description
The Bridge Modeler has been enhanced for precast concrete I-girder bridges with diaphragms at
support locations (bents and abutments) to connect the bottom of the diaphragm to the I-girder in
the case where the girders were modeled as frames. The connection is made using a stiff link
element between the bottom of the diaphragm and top of the girder, where the frame joint was
located. Previously the diaphragm was connected to the girder only at the top. The effect of this
change is local to the diaphragm itself. Spine models are not affected. Area models where the Igirder is model as mixed or areas are not affected.
The Bridge Modeler has been enhanced to provide some informative warning messages during
generation of a bridge model from the bridge object when the specified parameters create invalid
geometry. Examples include when a straight girder lies partially outside the deck in a highly curve
bridge, or when parametric variation reduces certain dimensions to zero or negative.
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*

Incident
83982

*

89789

90844

92861

94465

Description
The Bridge Modeler has been enhanced to allow control of the orientation for internal diaphragms
(cross-frames) in steel U-girder bridge sections at bent support locations. Previously, internal
diaphragms for steel U-girders were always generated perpendicular to the girder line at singlebearing bents regardless of the skew angle of the bent. Now an option is provided to generate the
internal diaphragm along the bent skew or perpendicular to the girder line. The default is now along
the bent skew, although the original behavior will be retained for older models when opened in the
new version unless changed by the user. Note that internal diaphragms for steel U-girders are
always aligned along the skew at double-bearing bents and at abutments.
The Bridge Modeler has been enhanced to allow definition of bents without cap-beams for use with
concrete box-girder bridges. Previously all bents required a cap-beam. Support bearings are located
at the top of each column defining the bent and connect directly to the superstructure.
An enhancement has been implemented to add typical Chinese tendon strands to the Tendon Area
Calculator used for defining tendons for bridge objects (command Bridge > Bridge Objects >
Prestress Tendons).
An enhancement has been implemented to the frame object submesh to now divide the object based
on the clear length instead of the full length. The clear length is equal to the full length minus any
rigid end offsets. This protects rigid end offsets from being overwritten when they are longer than
the meshed end elements containing them. This may change the location of output stations of old
models such that frame analysis and design results are changed. Previous version results were
accurate based on the previously used output stations.
Calculation of bridge section properties has been made more efficient by eliminating the recalculation of the torsional constant for identical section geometry at different section cuts. This can
speed up the time it takes to create the analysis model for certain bridge objects. The torsional
constant is calculated numerically for best accuracy, and this can take time for complex bridge
sections containing narrow dimensions, such as for composite steel girder sections.

Modeling
Enhancements Implemented
*

Incident
82049

*

90364

91114

93648

Description
A new Property Modifier assignment has been added for the link objects used to specify a scale
factor multiplying the stiffness, damping, and force/moment response of the object. The scale factor
applies equally to all six degrees of freedom, as well as the mass and weight. This allows the same
link property to be used for multiple link objects that may, for example, represent different size
tributary regions supported by the link objects.
An enhancement was implemented that allows model settings, such as material properties, frame
sections, load patterns, design preferences, and other definitions, to be saved and later used when
starting a new model. Each collection of settings is named and stored in the installation folder or the
user settings folder, so that appropriate settings can be chosen for different projects.
An enhancement has been implemented adding a new "Expected Concrete Compressive Strength"
to the concrete material property definition. This value is similar to the effective yield strength for
steel materials. This new value is used in the stress strain curves and concrete hinge definitions.
Creep and shrinkage analysis and concrete design still use the specified or characteristic
compressive strength previously available.
The axial force points used to generate Caltrans P-M2-M3, P-M2, and P-M3 hinges have been
changed to provide more accurate interpolation near zero axial force. Previously the interaction
surface was discretized uniformly in the axial (P) direction on both the tension and compression
added to the bridge seismic design preferences to allow specification of the number of axial and
angular discretization points for automatically generated Caltrans hinges. This specification already
exists for Caltrans hinges assigned by the user.
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Loading
Enhancements Implemented
*
*

Incident
90961

*

90967

91068

*

91458

*

88108

Description
An enhancement was implemented to update the Chinese vehicle library by adding the following:
(1.) CJJ 011-2011 vehicles,
(2.) Special live-load vehicle according to TB 10002.1,
(3.) JTG D60-2015 vehicles.
An enhancement has been implemented to update the Chinese response spectrum function definition
from JTG/T B02-01-2008 to the newer JTG B02-2013. Old models with a JTG/T B02-01-2008
response spectrum function defined will be updated to the new JTG B02-2013 response spectrum.
An enhancement has been implemented to update the Chinese bridge load combinations to the latest
code with the following changes:
(1.) Basic combinations are now referred to as Fundamental combinations ,
(2.) Combinations of short-term action effects are now referred to as Frequent combinations ,
(3.) Combinations of long-term action effects are now referred to as Quasi-permanent combinations,
(4.) The combination coefficient, psi_c, of variable actions is now 0.75 for fundamental
combinations.
An enhancement has been implemented to add the Chinese CJJ 166-2011 response spectrum
function.
An enhancement has been implemented to add the Russian SP 14.13330.2014 response spectrum
function.

Analysis
Enhancements Implemented
*

Incident
90244

91738

Description
An enhancement has been implemented to reduce the number of events generated by a layered shell
element. Event-to-event stepping can be used by nonlinear static and nonlinear direct-integration
time-history load cases to help control stepping and convergence. The use of events for the layered
shell element was introduced in version 18.1.0. For models with significant and localized
nonlinearity, using events can improve the rate of convergence and speed-up the analysis. For
models with widely distributed nonlinearity, a large number of events may be generated and this can
actually slow down the analysis compared to not using events. This enhancement will reduce the
number of events generated by a single layered shell element when many integration points are
defined over the thickness of the layered shell section. Additionally, the event behavior for
directional layered shell materials was altered to remove certain types of events. While the number
of events generated by a single element has been reduced, models with a large number of shell
elements and distributed widely distributed nonlinearity may still run better without event-to-event
stepping. Minor changes in results from versions 18.1.0 and 18.1.1 may occur due to this
enhancement for models containing layered shell elements and run using events, but the differences
should be within the convergence tolerance for well-conditioned models.
Internal improvements have been made to the force equilibrium and deformation compatibility
between frame hinges and their parent frame elements. This mostly affects fiber hinges and PMM
hinges while dropping load. The effect is generally small, but can be helpful for the new event-toevent strategies that have been added for nonlinear direct integration time history load cases. In
addition, multiple hinges in a single frame element will tend to perform better than previously,
lessening the need to assign frame hinge overwrites that auto-subdivide the frame object at the
hinges. This reduces the size of the analysis model and tends to increase the speed of the analysis.
Results for models with these hinges may differ from previous versions, although the difference will
generally be within the convergence tolerance for the load case. Models with P-delta may be more
significantly affected, particularly for those few cases where the deformations of the hinge and the
parent frame element were not fully compatible. For unstable and numerically sensitive models,
larger differences may be observed.
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*
*

Incident
93002

93037

*

90374

91429

93756

Description
The speed of moving load analysis has been increased for calculating the vehicle response for frame
objects and joint reactions. The effect will be most pronounced for those frames having many output
stations.
The "Hinge Unloading Method" parameter has been removed from nonlinear static and nonlinear
staged-construction load case definitions. This parameter only applied to isotropic hinges, and using
a non-default value was rarely useful in recent versions of the software. Now the default value
"Unload Entire Structure" will always be used. Models opened in the new version that previously
used a different setting may be affected, but this will not be common.
A pure event-to-event stepping solution strategy has been implemented as an option for nonlinear
direct-integration time-history load cases. This is in addition to the iterative event-to-event stepping
strategy already available for nonlinear static load cases and nonlinear direct-integration timehistory load cases. Time steps will be automatically subdivided where changes occur in the stiffness
of nonlinear elements. In contrast to the iterative method, more events will typically be generated,
but iteration for equilibrium will not be performed under the assumption that the deviation from
linearity will be small between events. Instead, any equilibrium errors are carried forward to the
next time step and applied as a corrective load. This is similar to the method used in Perform-3D.
This method may not be appropriate in cases with a large degree of geometric nonlinearity. Pure
event-to-event stepping can be more efficient than iterative methods for small to medium sized
models, but may not be so for large models with many nonlinear elements. Pure event-to-event
stepping can also be helpful for models where convergence cannot be achieved with iterative
methods, although the results should be reviewed for equilibrium.
Internal changes have been to increase the speed of nonlinear static and direct-integration timehistory analyses, including the use of parallelization of certain element processes. The effect on runtime will be problem-dependent. Results may differ from previous versions due to the change in the
order of numerical operations, but the differences are expected to be within the convergence
tolerance of the analysis. Larger differences may occur for some very sensitive or poorly
conditioned models.
The multi-threaded equation solver has been changed to provide more consistently repeatable results
when the same model is run more than once on the same machine. This change typically only
affects very sensitive or ill-conditioned models, which could produce slightly different answers
when re-run on the same machine. Previously the multi-threaded solver dynamically changed the
number of threads used based on machine conditions, which could change the order of numerical
operations and potentially affect sensitive results. Now the number of threads used defaults to the
number of physical cores on the machine, and can be changed with the environment variables
SAPFIRE_NUM_THREADS or SAPFIRE_NUM_THREADS_SOLVE. Furthermore, the order of
operations now is fixed for the same number of threads on a given machine, leading to more
consistently reproducible results. Sensitive models may still show differences between different
machines with different processors and/or different numbers of cores available. This change will
have little effect on most models, with the most significant effects being on long nonlinear time
history load cases for sensitive models.

Bridge Design
Enhancements Implemented
*

Incident
90743

Description
For bridge superstructure design of steel I-girder bridges using the AASHTO LRFD code (all
versions and iterims), the design request of type "Steel I Comp Strength" has been changed so that
the ductility requirement check per AASHTO Eq. 6.10.7.3-1 is now only applied to sections
experiencing positive moment demands. Sections that do not experience positive moment demands
are no longer verified for the Eq. 6.10.7.3-1. Previously sections subjected to only negative moment
demand that did not pass Eq. 6.10.7.3-1 were not checked further and no demand/capacity ratio was
computed. Now the demand/capacity ratio will be computed for such sections, provided all other
requirements are met. The previous behavior was over-conservative.
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*
*

Incident
91113

92134

*

93853

Description
An enhancement has been implemented to improve the following aspects of the Chinese bridge
seismic design according to JTG/T B02-01-2008.
(1.) The seismic design request parameter Seismic Design Category has been changed to
Substructure Category and the corresponding options are now Displacement Capacity Formula
(Single Column Pier) and Pushover Analysis (Dual Column Pier or Others).
(2.) A JTG/T concrete hinge model has been implemented.
(3.) The bent failure criteria and hinge limit state are implemented per the JTG/T requirement.
A new parameter "Is bridge curved?" has been added to the AASHTO LRFD Steel-I Comp Service
and Steel-U Comp Service superstructure design request that apply to steel I- and U-girder bridge
sections. This ensures the correct applicability of concrete stress compression limit in positive
moment regions. Previously these service checks were not taking into account if the bridge was
curved and was always applying the clause 6.10.1.1.1d concrete compression limit 0.6*f'c for
compact composite sections when the design request parameter "Shored construction?" was set to
"Yes". When this clause was not necessary, the design could be conservative.
Bridge live-load modeling and superstructure design and rating have been enhanced for the
AASHTO code to incorporate the following requirements for the Pennsylvania Department of
Transportation (PennDOT) Design Manual, Part 4, April 2015 Edition (DM-4):
(1.) New vehicles have been added per DM-4 Sections 3.6.1.2 and 3.6.1.3,
(2.) A new load pattern type "Live Load Deflection" has been added for use with vehicles that are
intended to check deflections per DM-4 Section 3.6.1.3.2,
(3.) An option has been added when generating default bridge load combinations for the AASHTO
code to consider the provisions of DM-4 Table 3.4.1.1P-1 for steel-girder bridges and Table
3.4.1.1P-2 for prestressed concrete-girder bridges,
(4.) An option has been added to the superstructure design and rating preferences for the AASHTO
code (all versions and iterims) to consider the provisions of DM-4 (a) Section 4.6.2.2 regarding liveload distribution factors, (b) Section 6.10.1.9.3P regarding web bend-buckling nominal flexural
resistance, and (c) Section 6.10.9.3.3 regarding end panels. Items (b) and (c) do not consider the
effect of longitudinal stiffeners.

Results Display & Output
Enhancements Implemented
*

Incident
68702

88036

Description
Correspondence can now be explicitly requested for the Analysis Results tables "Bridge Object
Forces" and "Bridge Object Girder Forces". Corresponding results were previously available by
selecting correspondence for load combos using command Display > Show Tables > Modify/Show
Options > "Multi-valued Response Combos", but this required at least one load combination to be
defined for this option to be available. Now this option has been renamed "Combos and Bridge
Moving Loads" and is also available whenever moving load results are present for a bridge object.
A minor change has been made to how the certain stresses are plotted in the Bridge Object
Response Display form (command Home > Display > Show Bridge Superstructure Forces/Stresses).
When plotting the "Longitudinal Stress - Top and Bottom - (S11)" for the left, center or right of the
entire bridge section of a spine model and choosing the Multivalued Options:
(1.) Envelope Max will plot the most positive values each for the top and bottom points,
(2.) Envelope Min will plot the most negative values each for the top and bottom points, and
(3.) Envelope Max/Min will plot the most positive value of the two points and the most negative
value of the two points.
Previously all three options plotted the top stress with the largest absolute value and the bottom
stress with the largest absolute value. The new options provide more information, but do not change
the correctness of the values plotted.
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Database Tables
Enhancements Implemented
*

Incident
86988

Description
An enhancement has been implemented to issue a message if trying to export database tables to
Microsoft Excel or Microsoft Access and the respective program is not detected on the computer.

Miscellaneous
Enhancements Implemented
*

Incident
88996

Description
The version number has been changed to v18.2.0 for a new intermediate update. CSiBridge v18 is
known as CSiBridge 2016.

User Interface and Display
Incidents Resolved
*

Incident
88643
90385
90896
90859

91154

Description
An incident was resolved where the label for the Vertical Mouse Pointer Location on the "Pushover
Curve" form could have been incorrect.
An incident was resolved in which the tooltip on the Assign Bridge Temperature Loads form would
flicker and become very large. This was a user interface issue only.
An incident was resolved in which certain text input fields on some of the forms did not accept the
CTRL+V key combination for pasting text into the textbox. This was a user interface issue only.
An incident was resolved on the Vehicle Data - Vertical Loading form in which the floating axle
loads width types were not correctly shown in the form when reviewing the loads of an existing
vehicle. The values used for analysis were visible in the database tables. This was a user interface
issue only and did not affect results.
An incident was resolved in which pressing F1 while in the construction scheduler opened a generic
help topic instead of the topic specific to the construction scheduler.

Graphics
Incidents Resolved
*

Incident
92459

Description
An incident was resolved where the numerical values were sometimes not shown when displaying
bridge loads assigned to a bridge object using the command Home > Display > Show Bridge Loads.
This was a display issue only and no results were affected.
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Bridge Modeler
Incidents Resolved
*

Incident
88426

89736

89757

90430

90801

91043

Description
An incident was resolved for the Bridge Modeler when the software could become nonresponsive
when generating a bridge model for a steel I-girder or U-girder bridge object having parametric
variations with very large changes in dimension over very short distances. This could result in poor
or illegal shapes for some of the generated elements. Previously this caused the nonresponsive
behavior, and no results were available. Now the model will be generated, but with any illegal
elements omitted. While such a model may not be desirable, it can be reviewed and corrected. It is
recommended to create more gradual transitions when using parametric variations, and to review the
generated model for adequacy.
An incident was resolved for the Bridge Modeler where the girder splices were not able to be
assigned to the right exterior girder. This option only applies to steel I-girder bridge sections.
Design results agreed with the model as generated by the Bridge Modeler. Analysis results are not
affected by splice assignments.
An incident was resolved for the Bridge Modeler where bridge support bearings were located
incorrectly for certain concrete box girder bridge sections using the General type of bearing
assignment (not girder-by-girder). In particular, the offset distance from the reference line was not
correctly calculated. Affected concrete box girder sections were (1.) Ext. Girders Sloped, (2.) Ext.
Girders Sloped Max, (3.) AASHTO - PCI - ASBI, and (4.) Advanced. No other bridge sections were
affected. When this error occurred, the error was obvious by looking at the generated model, and
results agreed with the model as generated.
An incident was resolved for the Bridge Modeler that corrected two issues affecting steel U-girder
bridge objects with skewed supports and modeled as area objects:
(1.) The area objects representing the steel U-girders near a highly skewed support could be
generated incorrectly. This could cause internal or external diaphragms to not be oriented normal to
the girders near the support, and/or could cause some area object representing the girders to protrude
beyond the end of the bridge at skewed abutments.
(2.) When a single bearing was assigned to each girder at the support location, the fixed link object
generated to connect the bearing and girder bottom might not properly connect to the girder bottom
if the support was skewed.
For each of these issues, the error was obvious by looking at the generated model, and results agreed
with the model as generated. Affected models can be corrected by the following steps:
(a.) Open the model in the new release of CSiBridge.
(b.) For each affected bridge object, use the command Bridge > Update > Clear All from Linked
Model.
(c.) Save the model file.
(d.) Reopen the model file.
(e.) For each affected bridge object, use the command Bridge > Update > Update Linked Model.
Note that custom modifications made to the previously generated model may need to be redone after
this process.
An incident was resolved for the Bridge Modeler where the Support Name could not be changed in
the Bridge Object Bent Assignments form (command Bridge > Bridge Objects > Supports > Bents).
The name would appear to be changed, but would be reset and/or generate an error message
whenever the "Bent Is At the End of This Span" was changed or the OK button was clicked. The
name could be changed using the interactive database editor. No results were affected. This name is
only used for identification.
An incident was resolved for the Bridge Modeler that addressed two issues affecting the assignment
of support bearings to steel U-girders when a bent property was used at the abutments:
(1.) At the Start abutment, a single support bearing was always generated for each U-girder even
when two bearings per girder was specified for all girders or in the bearing overwrites, and
(2.) At the End abutment, the number of bearings per U-girder specified in the bearing overwrites
was ignored, and the number of bearing specified for all girders was always being used.
In both cases, the error was obvious by looking at the model, and results agreed with the model as
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*

Incident

91356

91850

91891

92019

92076

92289

92839

Description
generated. The common case where abutment properties were used at the abutments was not
affected, only the case where bent properties were used at the ends.
An incident was resolved for the Bridge Modeler where the two adjacent spans would be incorrectly
constrained together at a double-bearing (discontinuous) bent when the bridge object was updated as
a spine model if either of the spans had a non-zero transverse offset at the bent. This could result in
an unexpected negative superstructure moment at the bent. This error did not affect bridge objects
updated as area or solid models. When this error occurred, results agreed with the constrained model
as generated.
An incident was resolved for the Bridge Modeler where the bridge model could be generated
incorrectly in certain cases when (1) The layout line was kinked, i.e., had an angle change between
two segments, and either (2a) A skewed bent support was located near the kink, or (2b) A skewed
bent support was located at the kink and parametric variation was applied to any transverse
dimensions. When this error occurred, transverse dimensions of the generated model could be
incorrect, although the error was consistent and easily observable. Results agreed with the model as
generated. This error was not common. It was introduced in version 18.0.0.
An incident was resolved for the Bridge Modeler where the geometry of the generated bridge model
could be incorrect at abutments having extremely large skew angles, particularly along curved
layout lines. This was not common. When it did occur, the error was obvious and results agreed
with the model as generated. This error could affect area and solid models, but not spine models.
An incident was resolved for the Bridge Modeler where steel I- and U-girder models may not be
correctly generated for multi-span bridge objects with skewed span-transition (bent-support)
locations under either of the following two conditions: (1.) The layout line also transitions from a
straight line to a curved line at the skewed span-transition location, or (2.) The specified
superelevation is not constant at the skewed span-transition location. When either of these
conditions occurred, the generated model was visibly not as expected, and results agreed with the
model as generated.
An incident was resolved for the Bridge Modeler that addressed two issues affecting bridge objects
with precast concrete U-girder bridge sections where any of the concrete U-girders themselves were
nonprismatic:
(1.) The bridge object could not be updated as a spine model if any diaphragms were assigned to the
bridge object. When this occurred, no results were available.
(2.) When updated as an area-object model, the thickness of the girder webs and bottom flange were
not being created correctly for the nonprismatic sections. When this occurred, results agreed with
the model as generated.
Neither of these errors affected bridge objects having only prismatic concrete U-girder sections,
regardless of whether or not the bridge section had any parametric variations.
An incident was resolved for the Bridge Modeler that addressed two issues with user-defined bridge
sections:
(1.) If temperature load had been assigned to a bridge object with a user-defined bridge section for
which any of the polygon points were defined with a non-zero radius, then the bridge object could
not be updated as a linked model. When this occurred, no results were available.
(2.) If parametric variations were assigned to some of the polygon point coordinates in the userdefined section such that the net number of polygon points in the section, after removing duplicate
(coincident) points, was different at two adjacent bridge section cuts, then the extruded view of the
spine model could not be displayed between those two section cuts. This was a display issue only
and no results were affected.
An incident was resolved for the Bridge Modeler where bridge objects using the concrete box girder
section could not be updated as a spine model under the condition where parametric variations were
assigned to the horizontal fillet at the top of the exterior girder and/or to the corresponding overhang
length such that at some locations along a span these two dimensions were equal but not at other
locations. When this occurred, the analysis could not be run and no results were available. This error
was not common, and it only affected bridge objects updated as spine models, not as area or solid
models.
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*

Incident
93501

93809

93856

Description
An incident was resolved for the Bridge Modeler where a support bearing at a bent or abutment
could be incorrectly located in the following case: (1.) The bearing assignment type was "General"
rather than "Girder-by-Girder" ("General" is available for concrete box girders only), and (2.) A
bearing overwrite was assigned to that bearing, and (3.) The bearing overwrite option "Bearing
Offset from Section Ref. Point" was not checked. In this case, the bearing was always located at the
section reference point rather than at the expected uniformly spaced bearing location. When this
occurred, results agreed with the model as generated from the bridge object.
An incident was resolved for the Bridge Modeler where a generated model might not have been
fully continuous at an internal bent support where the superstructure was specified as continuous if
the following three conditions applied: (1.) The bridge layout line was not straight horizontally and
vertically in one span adjacent to the bent, (2.) The bridge layout line was straight in the other span
adjacent to the bent, and (3.) The super-elevation was not zero at the bent. When this occurred,
results agreed with the model as generated. Models that exhibit this problem in an older version will
need to have their bridge objects updated in the new version to correct it.
An incident was resolved for the Bridge Modeler where any support bearing assignments to bents
and abutments that were specified by the user would be reset to default values for a bridge object
containing a user-defined bridge section that was attempted to be updated as an area or solid model.
A bridge object with user-defined bridge sections can only be updated as a spine model, and a
warning message is issued when attempting to create an area or solid model. The bridge object
definition should not have been changed in this case, and this has been corrected. When this error
occurred, results agreed with the model as generated.

Modeling
Incidents Resolved
*

Incident
91075

91317

Description
An incident was resolved where the time variation of stiffness was incorrectly applied for “User”
type time-dependent properties (command Define > Materials > Time-Dependent Properties >
Modify/Show Stiffness Curve). Rather than using the values of the Stiffness Multiplier specified by
the user, the square-roots of these values were being used instead. The value of modulus actually
being used in analysis could be seen using the Show Plot button available while defining the timedependent properties.
An incident was resolved in which an abnormal condition could occur when trying to delete hinge
properties for certain models.

Section Designer
Incidents Resolved
*

Incident
89705

89937

Description
An incident was resolved for Section Designer where the right-click grid form for editing the
properties of structural shapes did not always function correctly. In particular, if the user ever
clicked the material drop-down box, exited the form, and then used the right-click grid form again
to edit the same shape, then the shape name would be set to the material name and could not be
changed. No results were affected. Now the shape name can be edited if the shape was specified
parametrically, but not if the shape was imported.
An incident was resolved for Section Designer where the strain diagram plotted on the Moment
Curvature Form could be incorrect when the material stress-strain was not symmetrical in tension
and compression, with tension being stronger. This did not affect concrete, which is stronger in
compression. This was a plotting error only for the strain diagram. No other results were affected.
The moment-curvature curve was correct, as well as the stress and strain contours shown using the
Contour button on the form.
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*

Incident
93671
94292

Description
An incident was resolved for Section Designer where an abnormal termination error could occur
when displaying the PMM surface or moment-curvature curve for the fiber model of a section that
had more than 20 rebars tributary to any single fiber. Increasing the fiber discretization would avoid
this error. This was a display error only, and no results were affected.

Loading
Incidents Resolved
*
*

Incident
81191
83339
90624
93002

90582

*

91696

Description
An incident was resolved that addressed two issues that affect the lane loading points used to
generate bridge influence surfaces for moving load analysis:
(1.) When the influence line was kinked and the lane had width or was eccentric to the layout line,
incorrect loading points could be generated within the angle subtended by the normals to the layout
line on either side of the kink. This effect was generally local to the location of the kink (angular
discontinuity). Extra loading points could be generated on the acute-angle side of the layout line and
could be out of order. This affected the load applied to frame, shell, and solid elements. Loading
points on the obtuse-angle side of the layout line were correct, but could be affected by item 2 as
described below. In both cases the behavior has been improved by generating fewer, better-placed
loading points in the vicinity of kinks in the layout line. Note that this issue mostly affected lanes
defined from frames, where kinks are common. Bridge layout lines rarely have kinks.
(2.) Lane loading points sometimes connected to frame elements that were far from the location of
the loading point. This could occur because the connection was always being made by perpendicular
projection to the nearest frame element. While this is generally desirable, this could lead to
unexpected results when perpendicular projections cannot be found between the loading point and
any nearby frame elements. This could occur, for example, on the obtuse-angle side of a kinked
layout line as described in item 1 above. Now the perpendicular projections are also compared with
the distances to the ends of nearby elements to determine the shortest connection.
Note that item 2 does not affect lane loading points that connect to shell or solid elements, only to
frames. For both items 1 and 2, no load was lost, but the location of the load applied to the structure
could be different than expected. In both cases, the connections actually used could be viewed by
using the command Home > Display > Show Lanes.
An incident was resolved in which the scale factor values in the vehicle Length Effects form were
being converted each time the form was closed with the OK button if the units on the Vehicle Data
form were different from the database units.
An incident was resolved where API 4F (2008 and 2013) open-structure wind loads were not
correctly applied to cable objects. The error was significant and obvious, and could affect the
analysis and design results for load cases and load combinations that these loads. The loading on
frame objects was correct, only cable objects were affected. Affected models should be re-run with
the new version to check the results. All previous versions with API 4F open-structure wind loads
were affected.

Analysis
Incidents Resolved
*

Incident
38010

86424

Description
An incident was resolved where the reactions at restrained joints could show incorrect values in a
nonlinear static or staged construction load case with target force loading applied to elements
connected to those joints. Only the reported reactions were incorrect. The overall structural response
was correct and no other response quantity was affected. Only restraint supports were affected, not
springs or one-joint links.
An incident was resolved where mass-proportional damping specified on the materials was
incorrectly applied to the model for frame and solid elements in linear and nonlinear directintegration time-history load cases. For frame elements, the mass damping forces were incorrectly
applied to the element, which tended to underestimate the amount of damping. In addition, for a
frame element with non-zero insertion points, the damping force was applied at the insertion points
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*

Incident

92664

*

93487

Description
rather than at the joints where the mass is located; the effect of this on the results was generally
inconsequential. For solid elements with only material-based mass-proportional damping specified,
stiffness-proportional damping was also erroneously being included in the damping force. This
tended to overestimate the amount of damping, and also caused convergence issues when running
the nonlinear direct-integration time-history cases.
An incident was resolved where the stiffness-proportional damping matrix computed for line
springs and area springs was not being scaled by tributary length or area for nonlinear load cases.
For nonlinear direct-integration time-history load cases, the calculated damping was correct to
within the convergence tolerance, but the convergence behavior could be poor. For linear directintegration time-history load cases using the stiffness from a nonlinear load case, this caused the
damping to be overestimated for springs with smaller tributary regions and to be underestimated for
larger tributary regions. Linear direct-integration time-history load cases starting from the
unstressed (zero) state were not affected. Modal time-history analysis, including FNA, was not
affected.
An incident was resolved in which linear springs assigned to line, area and/or solid objects
sometimes provided stiffness along directions other than the chosen tension and compression
direction. The affected linear line/area/solid springs were only those specified as "Tension and
Compression", not "Tension Only" or "Compression Only". This error only happened when the user
displayed a linear link property that had non-zero stiffness along any of the directions other than the
tension/compression direction of the line/area/solid springs before running the analysis. Displaying
other types of link properties, even after initially displaying a linear link property, did not affect the
line/area/solid springs. Closing and re-opening the software temporarily resolved the issue, but did
not prevent it from reoccurring if a linear link property was displayed again before running the next
analysis. This was not a common problem, but when it occurred the error may not have been
obvious. Correct results were always obtained by opening the software and model, unlocking the
model (if locked), and running the analysis.

Bridge Design
Incidents Resolved
*

Incident
89723

91034

91481

Description
An incident was resolved for the superstructure rating of steel I-girder bridge sections where the
error message "Error locating section cut at Diaphragm for section ... in Span ..." would appear, and
the rating request would fail to run, under the condition that a bridge span was modeled as two or
more sub-spans and the number of girders in the up-station sub-span was more than that in the
down-station sub-span. Sub-spans are those spans that have no bent support at one end or the other,
and are used to model changes in the bridge section that occur between bents or abutments. Note
that, starting with this new version, an all-spaces type of diaphragm (cross brace) must be assigned
at the transition (no-bent) location between two sub-spans that have different numbers of girders in
their bridge sections.
An incident was resolved for bridge superstructure design where the AASHTO LRFD (all versions)
Steel-I Comp Strength design check would fail to run if the design request parameter “Use Stage
Analysis?” was set to “Yes” and the steel I-girder section was compact. When this occurred, no
results were available for the affected design request.
An incident was resolved for bridge superstructure design and rating of steel I-girder bridge sections
using the AASHTO LRFD codes where an error message "Error locating section cut at
diaphragm..." could be generated while running design/rating requests if a staggered diaphragm was
located very near, but not exactly at, a section cut. When this error occurred, the design/rating
request was unable to determine the unbraced length near the section cut. This caused the
design/rating request to fail and no results were produced. This error did not occur if the Cb
parameter was specified by the user in the design/rating request, since the unbraced length would
not need to be calculated in this case. This error affected the AASHTO LRFD steel I-girder bridge
Strength and Constructibility design requests and the Strength rating request.
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*

Incident
91521

*

91766

91776

*

92213
93417

*

93236

Description
An incident was resolved for bridge load rating of Steel I-girder bridges using the AASHTO 2007
and 2010 codes in the composite and noncomposite strength rating requests where the values of f0,
f1, fmid, f2, and Cb were reported incorrectly in the tables "Bridge Super Rating AASHTORATE10
23 - SteelINonCompStrgth-Flx" and "Bridge Super Rating AASHTORATE10 28 SteelICompStrgth-Flx". This was a reporting error only. The correct values were used in all
calculations and no other results were affected. In addition, the moment gradient calculation has
been added to the AASHTO LRD steel I-girder noncomposite strength rating request. In the
previous versions the Cb gradient was always assumed to be 1.0 when the "Method for determining
moment gradient factor Cb" in the rating request parameters had been set to "Program Determined".
This affects all versions and iterims of the AASHTO LRFD code.
An incident was resolved for bridge superstructure design of steel U-girder bridge sections where
the yield stress, fy, used for design was switched between the web and top flange. The actual value
of the yield stress used for design was reported in the design results tables, and all design results
were consistent with the reported value. Models where the same yield stress was used for both the
web and top flange were not affected. This error affected all steel U-girder ("Steel-U Comp ...")
design requests for all codes.
An incident was resolved for superstructure design of steel U-girder bridge sections using the
AASHTO LRFD code (all versions and interims) where the strength design check ("Steel-U Comp
Strength") could fail when processing positive moment demands if the U-girder section was
noncompact and the design request parameter "Use Stage Analysis" was set to "Yes". When this
occurred the error message "Unable to read valid stress point at steel beam bottom flange" was
produced, and affected results were not available. Results that were produced were not affected.
An incident was resolved that addressed two issues:
(1.) For a steel U-girder bridge section with top lateral bracing assigned to any of the girders, after
the model was saved and reopened, the frame section property assigned to the top lateral bracing
could be incorrectly changed to a different frame section. This could also cause the generated bridge
section cuts to be incorrect, affecting superstructure analysis and design results.
(2.) For a steel I- or U-girder bridge section, when an All Spaces or All Girder Interiors diaphragm
(cross frame) was assigned to a location that was closer to another section cut by a distance just
slightly greater than the merge tolerance, two section cuts could be generated so close together that
the aspect ratio of the girder area objects between them were invalid and excluded from the model.
This could significantly affect the stiffness of the girders. Results agreed with the model as
generated.
It will be necessary to update the linked bridge model for all bridge objects affected by this error in
order to correct the model after opening it in the new version.
An incident was resolved for bridge superstructure design of steel U-girder bridge sections where
stresses were not being correctly calculated when the option "Use Stage Analysis" was set to "Yes".
The reported stresses were too low, resulting in an under-estimation of the demand/capacity (D/C)
ratio. The effect of axial force was being ignored for the stresses calculated at the top and bottom of
the steel girder. This error affected all versions of all codes for steel U-girder strength and service
design requests with the option "Use Stage Analysis" set to "Yes", and the staged version of the
constructibility design requests. Results were not affected for strength and service design requests
when the option "Use Stage Analysis" was set to "No" or for the non-staged version of the
constructability design requests.

Frame Design
Incidents Resolved
*

Incident
92235

Description
An incident was resolved for AASHTO 2007, 2012, and 2014 concrete frame design in which the
seismic zone selected in the concrete frame design preferences was not always the value that got
used during design.
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Results Display & Output
Incidents Resolved
*

Incident
61893

82588

89048
89394

89748

89838

89912

91600

Description
An incident was resolved where the joint reactions in a staged construction load case that continues
from another nonlinear load case and that removes objects in the first stage were incorrect at joints
connected to the removed objects. The error in the reaction was equal to the amount of
force/moment carried by removed objects at those joints at the end of the previous load case. Only
the joint reactions at restraints were affected, and only at joints where objects were removed in the
first stage. Overall structural response was unaffected. No other displacement, force, moment, or
stress response was affected. This error only occurred at restraints, not at spring or one-joint link
supports.
An incident was resolved that corrected two items related to report generation.
(1.) An error would occur when generating a report from certain user-defined report content XML
files that contained no tables.
(2.) The group parameter of a picture element in the report XML contents file was not being
applied.
An incident was resolved where in rare cases some components of the joint reactions did not display
until the first time the load case or combination was changed for which results were displayed.
An incident was resolved where the sign of the major moment M3 displayed on the Bridge
Response Display form in the fields labeled "Response At Current Location", "Response Just
Before Current Location", or "Response Just After Current Location" could be incorrect after
clicking the "Refresh" button in the case when the option "Moment Diagrams on Tension Side" was
selected in the Other Settings form. The error was obvious because the sign of the displayed values
was opposite that of those plotted in the graph on the same form. No other results were affected.
The Bridge Response Display form is accessed using ribbon command Home > Display > Show
Bridge Superstructure Forces/Stresses, and the Other Settings form is accessed using the ribbon
command File > Settings > Other Settings.
An incident was resolved where the Bridge Object Response Display form (command Home >
Display > Show Bridge Superstructure Forces/Stresses) was unable to display analysis results for a
bridge object containing a bridge section of type Concrete Box Girder - Ext. Girders Sloped Max
when the bridge object was updated as a solid model. This was a display issue only. No results were
affected.
An incident was resolved where moving load case results could fail to display on the Bridge Object
Response Display form (command Home > Display > Show Bridge Superstructure Forces/Stresses)
for a bridge object with a concrete bridge section that had been updated as a solid model. When this
error occurred, it could result in the response being plotted as zero, generating an error message
saying that results could not be recovered, or an abnormal termination. When the error did not
occur, the displayed results were correct. Affected concrete bridge sections that can be updated as
solid models are the Box Girder, Tee Beam, and Flat Slab sections. No other results were affected.
An incident was resolved where the plotted potential and hysteretic energies for FNA load cases
were wrong for certain types of link objects: Multilinear Elastic, Gap, Hook, Plastic (Wen), Rubber
Isolator, and all three Friction-Pendulum Isolators (the first three types exhibit potential energy
only). When this error occurred the effect was usually obvious from the unrealistic plots, which
could include negative energies. No other results were affected. Versions 17.2.0 to 18.1.1 were
affected.
An incident was resolved for bridge superstructure design and/or rating of steel I-girder and Ugirder bridges where the design/rating results for the right exterior girder were sometimes reported
as zero in the Bridge Object Response Display form when the number of girders varied in different
bridge spans. This could occur in spans that had more girders than present in the first span of the
bridge object. This was a display issue only and no results were affected.
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*

Incident
91763

91841
92254
92365
*

93548

94642

Description
An incident was resolved where single degree-of-freedom frame hinges using the Takeda hysteresis
model could sometimes indicate that yielding had occurred at force or moment values lower than
the specified yield value (point B). This could occur the first time the force value changed sign.
Only the reported state (past point B) was affected, not the actual force-deflection or momentrotation behavior. No other results were affected. This error did not affect other hysteresis types
(isotropic, kinematic, Pivot).
The descriptions of the database table columns (fields) were missing for all AASHTO LRFD steel
U-girder bridge superstructure design result tables. No results were affected.
An incident was resolved where the units used in a report may not be those expected the first time
the report is created.
An incident was resolved where bridge stresses could not be plotted on the Bridge Object Response
Display form for certain models. No other results were affected. This was not common.
An incident was resolved where the stresses computed for the flanges of a steel I-girder in a bridge
object could be incorrect at certain bridge section cuts in the case when a nonprismatic hybrid I
frame section was assigned to the steel I-girder bridge section and either (1.) the bridge section cut
was near to, but not at, the location where a section transition that changed the top flange
dimensions, or (2.) the bridge section cut was at a location where the top or bottom flange
dimensions were tapered (varied linearly). When this occurred the flange stresses displayed in the
Bridge Object Response Display could be incorrect, since the flange thickness was taken as double
its specified value. In addition, this could affect the bridge design results for design requests with
the “Use Staged Analysis” option set to "Yes" due to incorrect flange stresses. Such design requests
should be re-run for verification with the new version. This error only affected steel I-girder bridges
modeled as area objects with the girders using the mixed model, not the frame or area models for
the girders. This error did not affect the analysis model or any analysis results except the flange
stresses in the Bridge Object Response Display.
An incident was resolved where the user-specified range for various types of plotted response
contours was always being set in database units rather than user-selected display units. This affected
the contour display for displacements; soil pressures; frame stresses; shell resultants, stresses, and
design results; and the stresses for plane, asolid, and solid elements. Only contour results were
affected. All other results were correct, including the values shown under the mouse cursor and in
the right-click details forms. Contour results were only incorrect when the display units selected in
the lower-right corner of the graphical user interface were different from the database units, which
are the units selected whenever the model is opened.

Database Tables
Incidents Resolved
*

Incident
64725

Description
An incident was resolved in which using the interactive database to input user-defined time history
functions with a large number of data points would either freeze the user interface or only partially
import the data. This issue was previously resolved in v17.2.0 but inadvertently omitted from the
release notes.

Data Files
Incidents Resolved
*

Incident
79862

Description
An incident was resolved where an error was generated when importing a model text file containing
precast-I or U sections imported from a XML library. When this happened the section was imported
as a default section instead of the expected precast section and the results reflected this.
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*

Incident
89236

91727

Description
An incident was resolved where staged-construction Schedule data were not properly imported from
CSiBridge text/table files (.b2k, .$br, .xls, .xlsx, .mdb, .accdb) if any of the group names referenced
in a Schedule contained a space character. When this occurred, an error message was generated
during import. The Schedule data itself was correctly imported, but any staged-construction load
cases generated from the imported Schedules would have no operations defined for the stages. This
was able to be corrected by using the Modify/Show operation for each staged-construction load
case, and then clicking OK to update them. No other data was affected.
An incident was resolved for the Bridge Modeler where updating the linked bridge model would fail
for Steel I- or U-girder bridge sections and for concrete I-girder bridge sections if (1.) Parametric
variation was assigned to the first span, and (2.) One or more staggered diaphragms were assigned
between the first and second section cuts. When this occurred, the model could not be generated and
run, so results were not available. Adding a user-defined discretization point before the first
staggered diaphragm was an option to avoid this problem.

Application Programming Interface
Incidents Resolved
*

Incident
89069
89446
91921
89961

Description
An incident was resolved where some API users creating 32-bit COM clients were experiencing
'Runtime error "429": ActiveX component can't create object', when attempting to use the 64-bit
program via the API. This has been resolved as part of the installation process.
An incident was resolved in which the API for the v18.0.0 and v18.0.1 64-bit version still used the
same GUIDs as v17 and these GUIDs were different than v18 32-bit API. This could cause an issue
for COM clients in the following scenarios.
(1.) If v17 and v18 64-bit were installed on the same machine, the API client may connect to the
wrong instance of SAP2000.
(2.) A v18 API client couldn't work with both the 32-bit and 64-bit without having two different
versions of the client, compiled against the different API assemblies.
This issue was resolved in v18.1.0 but was inadvertently omitted from the Release Notes.

Documentation
Incidents Resolved
*

Incident
90091

90431

92252

92175

Description
An incident was resolved in which the Define Load Patterns help topic referred to load pattern types
'Super Dead' and 'Reduce Live' which are not available in CSiBridge. The documentation has been
updated.
An incident was resolved in which the concrete frame design manual for CSA A23.3-14 contained
references to Chapter 4 in the table of contents but there was no Chapter 4 in the manual. This was
only an error in the table of contents.
An incident has been resolved in the concrete frame design manual for ACI 318-14 code in which
the expression of T_th had a term (A_cp/p_cp)^2 instead of (A_cp^2 / p_cp). This was a
documentation issue only and did not affect design results.
An incident was resolved in which the steel frame design manuals for AISC 360-05 and 360-10
incorrectly documented the equation for Fez in section 3.5.2.1.2.3.4. This was a documentation
issue only and did not affect design results.
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External Import/Export
Enhancements Implemented
*

Incident
70171

Description
An incident was resolved in which some general reference lines imported from LandXML files were
unable to be converted to layout lines. This typically happened when the beginning or ending
stations were not consistent between the horizontal and vertical layout data. Now the horizontal and
vertical layout are adjusted at either end to make them compatible and allow the general reference
line to be converted to a layout line.

Installation and Licensing
Incidents Resolved
*

Incident
84181
84655
73430

Description
An incident was resolved in which installing CSiBridge using System Center Configuration
Manager (SCCM) could fail due to a permissions issue. This was resolved with the release of
CSiBridge 2016 v18.0.0.
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